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Experiment 11:  Molecular Mechanics and Modeling 
 

Purpose: One purpose is to have some fun learning about molecular modeling and mechanics. 
The other purpose is to begin to appreciate how complex molecules are built from small 
molecule building blocks. 
 
Introduction 
 

   At this stage in your college career, you might be wondering how the careful description of 
molecular structure pertains to your eventual goals. If you are interested in the molecular life 
sciences, you will in later courses, such as Organic Chemistry, Biochemistry, Genetics, and 
Immunology continue to unravel the intricate relationship between molecular structure and 
function. In Chemistry, molecular structure is central to everything we do. Geologists relate 
molecular structure to mineral properties in Mineralogy. Physicists study aspects of molecular 
structure in solid-state physics and statistical mechanics courses, to name a few. But for now, it 
might be inspiring to look at an example where careful consideration of molecular structure was 
really necessary in helping to save human lives.1,2 

   The example we will use is the anti-viral protease inhibitor Indinavir, Figure 1. Indinavir was 
designed to bind in the active site of HIV-protease to block its normal activity, which is 
necessary for HIV infection. HIV-protease is a complicated protein. However, we will focus on 
just one small aspect of the interaction of Indinavir with the binding site. 
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Figure 1. Indinavir. Most of the hydrogens have been left off to make the structure easier to see. 
We will focus on just the central –OH group. 
 
   Chemists often look at large molecules as being made up of small molecules. Nature is very 
conservative; the same interactions that act in small molecules are active in the very largest 
molecules. Therefore, mentally breaking down large systems into their component small 
molecules is an important part of understanding large systems. The bond angles and lengths we 
find in small molecules are good predictors of the bond angles and lengths in large systems.  
   "Ball and stick" wooden or plastic models give us some sense of the way atoms are arranged in 
molecules and of the molecule's three-dimensional structure. However, if a model is to be really 
useful it must be more than an artistic representation. The model must be a tool for predicting 
properties and behavior. In this experiment, we will explore the computer program "the 
Molecular Operating Environment," or MOE, which uses molecular mechanics to calculate the 
conformational energy of molecules. One advantage of molecular mechanics is that it is a very 
rapid technique that can be used on very large molecules such as proteins. Conformational 
analysis using molecular mechanics creates very useful models for the study of molecular 
structure and molecular interactions. Molecular mechanics is the principle computational tool for 
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structure studies in Structural Biology and Biochemistry. 
 

Amino acids and Proteins 

Proteins are composed of many amino acids joined by peptide bonds. Three of the 20 naturally 
occuring amino acids are shown in Figure 2. The amino acids differ based on their side chains 
(shown in grey). Also shown is the peptide bond between two glycines. The peptide bond is 
formed when the O=C-OH on one amino acid reacts with the H2N- on the next amino acid, 
forming an O=C-NH- bond. The HIV-protease we are studying has 198 amino acids joined by 
peptide bonds. We will focus on the interaction of the central –OH in Indinavir and one of the 
aspartates (ASP, the ionized form of the side chain). 
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Figure 2. Three common amino acids. On the bottom structure a peptide bond is formed between 
two glycines. 
 

Molecular Mechanics 
 

Molecular mechanics uses classical physics to build structural models for complex molecules. 
Atoms bonded to each other are treated as masses joined by springs. The energy required to 
stretch or compress a bond is shown in Figure 3.  
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Figure 3.  Bond Stretching 
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Bond stretching and bending Energy:  A bond can be thought of as a spring having an 
equilibrium length, ro, and the energy required to stretch or compress the bond can be 
approximated by: 
 Estr = ½ k ( r - ro )2        (1) 
 

where k is the stretching force constant for the bond and r is the distance between the two atoms. 
Strong bonds have large force constants and weak bonds and the bending of bonds have small 
force constants. (The determination of the force constant for the bond in nitric oxide will be 
determined in another lab this semester.) Atoms that are not directly bonded can also interact.  

 
Conformational Analysis 

 

The shape of a molecule is determined by the bond lengths and angles between its atoms. The 
bond length between a pair of bonded atoms, A-B, is primarily determined by the hybridization 
of the two atoms. The bond angle of three directly bonded atoms, A-B-C, is determined primarily 
by the hybridization of the central atom, B. However, these lengths and angles are not enough to 
predict the shape of complex molecules. Rotation angles around bonds are also necessary to 
specify the conformation of a molecule.  
   As you have discovered in the "balls and sticks" discussion section, singly bonded atoms can 
rotate around their bonding axis. This rotation of single bonds usually requires only small 
amounts of energy. Thus, at room temperature many singly bonded atoms rotate freely. Single 
bond rotations play an important role in determining molecular shapes. The amount of rotation 
around a bond determines the conformation of the bond. The quantity which specifies the 
conformation of a bond is the dihedral angle. The dihedral angle is the angle between the 
substituent atoms attached to the bonded atoms being considered, Figure 4.  
 
 
 
 
 
 
 
 
 
 
 

Figure 4. The Dihedral Angle for the O-O bond in H2O2. 
 

Some dihedral angles are energetically more favorable than others. We only consider those 
bonds whose rotation will change the relative positions of atoms in the molecule (e.g. the O—O 
bond but not the H—O bonds of H2O2).  
   The most important factors that effect the energy of the molecule as the dihedral angle changes 
are the Van der Waals, electrostatic, and dihedral energies. 
 

Van der Waals Energy: Van der Waals interactions between pairs of atoms influence the 
energy of a conformation. Van der Waals interactions are often the most important factors in 
determining the overall molecular conformation (shape). Such interactions are extremely 

Dihedral angle 
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important in determining the three-dimensional structure of many biomolecules, especially 
proteins. You will also learn that Van der Waals interactions also act between molecules and are 
responsible for the liquefaction of non-polar substances like O2 and N2. 
   A plot of the Van der Waals potential energy as a function of distance between two hydrogen 
atoms is shown in Figure 5. When two atoms are far apart, an attraction is felt. When two atoms 
are very close together, a strong repulsion is present. Attractions lower the energy of a molecule, 
while repulsions raise the energy of a molecule. A measure of the size of an atom is its Van der 
Waals radius. The distance that gives the lowest, most favorable, energy of interaction between 
two atoms is the sum of their Van der Waals radii. The lowest point on the curve in Figure 5 is 
this point. Interactions of two atoms separated by more than this minimum energy distance are 
governed by attractive forces. At distances smaller than the minimum energy distance, the atoms 
repel each other.  

 

 
Figure 5. Van der Waals interactions between two hydrogen atoms in a molecule, such 

as ethane. 
 
Electrostatic Energy: Atoms in molecules have partial electric charges, which are caused by the 
polarity of the bond to the atom. For example, the hydrogens in H2O and H2O2 are slightly 
positive, because the O-H bond is polar. The O-H bond is polar because oxygen is more 
electronegative than hydrogen. Like-partial charges repel and opposite-partial charges attract. 
These attractions and repulsions are called electrostatic interactions. Electrostatic interactions 
have an effect on the conformations of molecules. In H2O2 (Figure 4) for example, the two 
positively charged hydrogens will try to avoid each other. With a 0° dihedral angle the atoms are 
close together and electrostatic repulsion will be at maximum. As the dihedral angle increases, 
the H atoms are further apart, decreasing the repulsions, and therefore lowering the energy. 
   The electrostatic interactions are calculated with the Coulomb potential function: 
 

  Eqq   =   
k  Qi Qj

 4πε r
        (1) 

 

The Qi and Qj are the partial atomic charges for atoms i and j separated by a distance r. ε is the 
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molecular dielectric constant (normally 1.0), and k is a units conversion constant. Remember that 
this is the same Coulomb potential function that governs the attraction of electrons for the nucleus 
in an atom. The Coulomb potential for a unit positive and negative charge is shown in Figure 6a 
and the Coulomb potential for the two hydrogens in H2O2 is shown in Figure 6b. 
 

Figure 6. (a) Coulomb attraction of a positive and a negative charge. (b) Coulomb 
repulsion of the two hydrogens in H2O2, with the charge on each hydrogen as Q1 = Q2 = 
0.210. 

 
Dihedral Energy:  Two possible conformations of ethane are shown in Figure 7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 a. Eclipsed, Dihedral Angle = 0°  b. Staggered, Dihedral Angle = 180° 
 

Figure 7. Dihedral angles for ethane. In the structures all hydrogens are equivalent, 
however one particular hydrogen on the front of the molecule and one on the back are 
shaded so that you can follow the change in the dihedral angle for a given pair of 
hydrogens. 

 
The eclipsed conformer is higher in energy than the staggered form. The increase in dihedral 
energy of the eclipsed form is caused by the repulsion of the electrons in the C-H bonds on 
different ends of the molecule. In the staggered form, the bonds are further apart thus reducing 
the electron-electron repulsion between the bonds. A plot of the dihedral energy of ethane is 
shown in Figure 8. The energy penalty of having eclipsed bonds rather than staggered bonds is 
seen to be 2.7 kcal/mol (11.3 kJ/mol). The energy curve has three minima because the three 
atoms attached to each end of the molecule are the same. Therefore, the conformations with 
φ = 0°, 120°, and 240° are all identical eclipsed conformations. The conformations with φ = 60°, 
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180°, and 300° are all identical with staggered, low energy conformations. Locate these energies 
in Figure 8. 

  
Figure 8. Dihedral energy in ethane.  

 
The terms dihedral energy and torsional energy are used interchangeably, depending on the 
computer program. The dihedral energy is only calculated for atoms that are separated by three 
contiguous bonds, such as the hydrogens in ethane and H2O2. 
 
Energy Minimization:   The conformational energy of a bond is the sum of the bond stretching 
and bending energy, Van der Waals energy, the electrostatic energy, and the dihedral energy. 
The lowest energy conformation is the angle that gives the smallest total energy. In other words, 
bonds find a compromise among competing forces to determine the lowest energy conformation. 
The goal of this experiment is to use a computer model to determine the lowest energy 
conformation of Indinavir. The process is called energy minimization. The computer makes 
small changes in the position of every atom and calculates the energy after every move. The 
move is kept if the energy is lowered, otherwise the atom is returned to its original position. This 
process is repeated many times until an overall energy minimum is reached. One full cycle, 
where each atom is moved once, is called a minimization step. Hundreds of steps may be 
necessary to find a reasonable structure for the molecule. 
 
Summary:  In summary the conformational energy of a molecule is determined by the: 

1. Bond stretching and bending energy: The atoms are treated like they are attached by springs; 
the springs try to reach their equilibrium lengths. 

2. Van der Waals energy: At large distances atoms are attracted to each other, but at very short 
distances, atoms repel each other. 

3. Electrostatic energy: Like charges repel and opposite charges attract; the partial charges on the 
atoms are from polar bonds. 

4. Dihedral energy: The electrons in bonds on the opposite atoms of a bond repel each other. 

5. The energy = Bond stretch & bend + Van der Waals + Electrostatic + Dihedral 
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PROCEDURE 
 

Methanol:  In this part of the exercise we will build methanol, use molecular mechanics to find 
the minimum energy conformation, and construct the dihedral angle energy plot to show the 
torsional potential for the C-OH bond. The energy units in MOE are kcal/mol. 
 

1. Double click on the MOE icon on the desktop. The MOE window should appear. 
 

2. Builder   Click on the Builder…  button on the right of the screen. Drag the Molecule Builder 
tool palette to the right-hand side of the screen, so that you can see the main MOE window. Click 
on the “C” button in the Element section on the upper left-hand side of the tool palette. Methane 
should appear in the MOE window. Next click on one of the hydrogens on the methane, then 
click on the "O" button in the Element section. The hydrogen atom should be changed to an OH, 
Figure 9. The 3D structure is constructed using tabulated values of bond lengths and angles. 
Close the Molecule Builder window. Red is for oxygen and blue for nitrogen. 
 

 
Figure 9. Methanol with the atoms in the dihedral numbered in the order to click on. 

 
3. Rotations,Translations, and Zooming    To change the orientation, size, and position of the 
molecule, you can use either of two methods, (1) using the mouse or (2) using the Dial palette. 
 

Rotations,Translations, and Zooming    To change the orientation, size, and position of the 
molecule, you can use either of two methods, (1) using the mouse or (2) using the track ball (the 
soccer ball). To use the mouse, position the cursor in the main window and hold down the center 
mouse button. Dragging with the center mouse button reorients the molecule. If you wish to 
rotate the molecule only around the axis perpendicular to the screen, hold down the middle 
mouse button and drag the cursor in the periphery of the molecule window.  
 

   Middle: Reorient molecule—xyz rotation 
   Middle and drag in periphery of viewing area: rotate around z only 
   Shift-Middle: xyz translation 
   Ctrl-Middle: zoom in and out or use the roller 
   Alt-Left: change dihedral angle between two selected atoms 
 

   Alternatively, you can use the track ball. Dragging with the left mouse button on the track ball 
rotates the molecule. To translate the molecule, click on the �  button in the lower-left hand 
side of the track ball box, the button will switch to a ↔ ↨ . Dragging with the left mouse button 
over the track ball then translates the molecule. To switch back to rotation, click on the ↔ ↨  
button. In other words the �   and ↔ ↨  buttons toggle between the two states. To zoom the 
molecule drag with the left mouse button over the thumbwheel,   |   |  , that is located just below 
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the track ball. Clicking on Center  at the right of the screen will allow you to start fresh with a 
centered molecule. Your molecule should appear as shown in Figure 9. You can also change the 
atom rendering. Click on the Atoms button in the “footer” bar that runs across the bottom of the 
screen: 
 

    
 
Click on the O=O  button for ball-stick rendering. Try all six of the rendering options.4. Click on 
the Minimize…  button at the right-hand side of the screen. The molecular mechanics 
minimization will be run to give a low energy conformation for the molecule (that is close to 
your originally drawn structure). Visually compare the approximate bond angles in this structure 
to the structure you build using the wooden balls and sticks. 
 

5. We can now show the dihedral dependence of the molecular mechanics energy. Click and then 
shift click on the four atoms on the ligand that define the dihedral angle in the order: H-O-C-H. 

The four atoms should be pink showing that they are selected. Click on the graph  button in 
the footer bar. The dihedral energy plot should appear, which should look very similar to Figure 
8. The vertical axis units are kcal/mol and the green line indicates the current dihedral angle. 
Click on the plot to move the current dihedral angle. What is the conformation for the other low 
energy conformation? The current dihedral angle is listed in the lower left at the bottom of the 
screen. (answer: 60° dihedral). The green line is drawn at the current value of the dihedral angle, 
which should be at a minimum energy point, since we have just done a molecular mechanics 
minimization. This plot includes all the energy terms, stretch and bending, Van der Waals, 
electrostatic, and torsional. However, for methanol the torsional interaction dominates the total 
change in energy with dihedral angle in this plot. Sketch this plot in your lab notebook, including 
axis scales, axes labels, and units. Make sure to note the maximum and minimum energies. 
When finished click Close on the Plot window. 
 

6. Before going on to the next section, click on the Close button at the right-hand side of the 
MOE window. Click on the OK button to close the current molecule. 
 
HIV-Protease and Indinavir:  In this part of the exercise we are going to start with the global 
view and then focus on smaller and smaller portions of the structure. As we delete more atoms, 
however, we will look in greater detail at the molecular structure and interactions. In the end we 
will end up with ethanol and relate these structures back to the Lewis dot ball and stick models in 
Part 1 and the methanol calculations you just completed. The structure for this HIV-protease 
complex is taken from the Protein Data Bank (1HSG.PDB).1 These atom positions were 
determined using X-ray crystallography. This structure and similar structures were used to 
design the drug Indinavir, which is now commonly used for the treatment and prevention of 
AIDS infections. The molecule that is docked in the binding site of a protein is called the ligand, 
which is Indinavir in this case. 
 

Click for space filling 
(VDW) display 
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1. Pull down the File menu and choose Open. Navigate to the Documents directory and the 
moefiles subdirectory. Click the CWD button to select this directory as your default. Then 
choose "1hsgcartoon.moe" and click OK. 
 

2. The HIV-protease should be shown in cartoon form, with the ligand rendered in Van der 
Waals spheres. The yellow areas show regions of the protein that are in the "beta pleated sheet" 
form. This form for the protein backbone produces flat extended regions. The red regions are in a 
more compact helical form. This view shows the drug neatly tucked under two folds of beta 
pleated sheet. To see these regions in more useful molecular form, continue on. 
 

3. Click on the Ribbon button in the bar that runs across the bottom of the screen: 
 

            
 
Click on the ∧    ∧  button to display the protein backbone. (Try out the other buttons to see the 
effect, but return to the backbone display with Structure coloring.) The atom positions in the 
protein chain backbone will now be shown. The color-coding will be the same as in the original 
cartoon. Rotate the structure to note the helical arrangement of the red alpha helical regions. 
Then click on the BB  and SC  buttons to show all the non-hydrogen atoms. Now all the non-
hydrogen atoms will be shown. If you go on in biochemistry or molecular biology, you will learn 
how to unravel the functional implications of protein structure. However, for now we just want 
to note that HIV-protease is just a big mess-of-atoms. What we want to do now is to reduce the 
complexity by focusing on just one particular part of Indinavir and its interaction with the 
protein. 
 

4. Make sure the rendering style for all atoms is the line style. To ensure that all the atoms are 
labeled by element, click on the Atoms button and then select the Element  button in the Color 
selection group in the bottom row of the Atoms dialog box. Pull down the Select menu and 
choose Ligand. Pink coloring now highlights just the ligand atoms. Click on the Atoms button 
and choose the light green color. In general note that: 
 
An action is applied to selected atoms only. If no atoms are selected, the action is applied to all 
atoms. 
 
Pull down the Select menu, slide right on Extend, and choose Near (4.5A). Pull down the Select 
menu, slide right on Extend, and choose Residue. Now all the amino acids near the ligand 
should be highlighted. Pull down the Select menu and choose Invert . Click on theDelete  button 
at the right-hand side of the screen. Click on OK in the Delete dialog box if displayed. Now only 
the amino acids close to the ligand should be shown.  
 

5. Click anywhere in the black background to make sure no atoms are selected (no pink atoms). 
To see the fit of the ligand in the binding pocket of the enzyme, click on the Atoms button and 
choose space filling display, O    O . Notice that the ligand and the enzyme are in close contact, 

Click for 
backbone 
display 

Click for backbone atom display 
Click for side chain atom display 
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with little or no empty space remaining. This is because the medicinal chemists who designed 
Indinavir built the drug to efficiently pack into the available space, and also the flaps of the 
enzyme are flexible and collapse around the ligand. 
 

6. The ability of the enzyme to bind Indinavir is the combination of many small specific 
interactions. We will focus now on just one of these, a hydrogen bond.  

 
Figure 10. Indinivir and aspartate 26 from HIV protease. 
 
Click on the Atoms button and choose thin line rendering. Pull down the Window menu and 
choose Sequence Editor… First click on the first "ASP" in the sequence (amino acid 3). Click 
right on this "ASP", click on Atoms, and then click on Select. A few atoms in the enzyme should 
now be selected. Now click on the "MK1" (the last entry). Once again, click right on this "MK1", 
click on Atoms, and then click on Select. The ligand should also now be selected along with the 
single ASP. Close the Sequence Editor window. Pull down the Select Menu and choose Invert . 
Click on the Delete  button on the right- side of the screen. Now only Indinivir and one ASP 
should be on the screen. Click on the Atoms button and choose Element  in the Color group. The 
screen should appear as shown in Figure 10. 
 
7. Notice that there are no hydrogens in either molecule. This lack is because X-ray 
crystallography is not sensitive to hydrogen atoms. We must use molecular mechanics to fill 
these in. Structures without hydrogens are very unrealistic, because most of the important 
interactions between molecules are mediated through the hydrogens. However, before we add the 
hydrogens we need to fix the position of all the current atoms, since the position of these non-
hydrogen atoms are fairly well known from the X-ray experiment. Use the mouse to drag a 
selection box around all the atoms on the screen (all atoms should have pink highlighting). Then 
select the Constrain button at the right-side of the screen and select Fix. To add the hydrogens, 
pull down the Edit  menu and choose Build, slide right Hydrogens and slide right to choose Add 
Hydrogens. Click anywhere in the black background to make sure no atoms are selected (no 
pink boxes). Now click on the Minimize  button to apply molecular mechanics minimization for 
all the hydrogens. Click on the Atoms button and choose ball and stick rendering. The OH on the 
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central part of the molecule should swing around to interact with the COO- on the ASP, Figure 
11. To display the hydrogen bond, click on the Contacts button on the bottom of the screen: 
 

  
 

Make sure the check mark is visible to the left of the H Bond label, this button toggles hydrogen 
bond display. The button to the right of the H Bond label controls the rendering style for the 
hydrogen bond. The default displays a small cylinder in the middle of the bond, with length 
proportional to the hydrogen bond strength. Try all the options, which include no label, cylinder 
style, the bond strength in kcal/mol, and the bond length in Å. In the Contacts panel, the 3x3 
matrix of buttons controls the display of interactions between receptor (Rec), solvent (Sol) and 
ligand (Lig) atoms. The button colors show the rendering style for the interactions: green for the 
rendering style from the top of the panel, yellow for thin dashed lines and gray to turn off the 
display for those contacts. Click the BB option to see hydrogen bonds among peptide backbone 
atoms. The number in the scroll box selects the interaction energy cut-off for labeling a hydrogen 
bond. Increase the cut-off to 1.5 kcal/mol to focus on moderately strong hydrogen bonds. Zoom 
in to identify the hydrogen bond between the ligand and the protein. Have your instructor check 
your screen at this point. 
 

 
Figure 11. Hydrogen bond between Indinivir and aspartate 26 from HIV protease. The dashed 
line was added to help guide the eye to show the hydrogen bond to the COO-. 
 
8. We now will compare the dihedral energy plot for the –OH in Indinavir with the plot from 
methanol. Click and then shift click on the four atoms on the ligand that define the dihedral angle 
in the order: H-O-C-H. The four atoms should be pink showing that they are selected. Click on 

the graph  button in the footer bar. Click on the plot to move the current dihedral angle. The 
solid line is the dihedral (torsional) energy of the displayed structure, ligand and protein. The 
dotted line corresponds to the ligand dihedral energy in the absence of the protein. Is the 
minimum energy conformation in the presence and absence of the protein the same (do the solid 
and dotted lines have the same minimum energy dihedral angle)? Sketch the dihedral energy plot 
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in your lab notebook, including axis scales, axes labels, and units. Note the maximum and 
minimum energies. This dihedral plot is very different than the plot for methanol because of the 
interactions with the aspartate and particularly the formation of a hydrogen bonding interaction 
with the COO- of the aspartate. Note however, that the minimum energy angle is not much 
different from one of the minima in the methanol dihedral plot you did above. In other words, the 
low energy conformation for free methanol and the –OH group in the binding pocket are very 
similar. This similarity and the strength of the interaction between the –OH on Indinavir and the 
COO- from aspartate make an important contribution to the efficacy of this drug. When finished 
click Close on the Plot window. 
 
8. Now we are ready to relate the structure of Indinavir back to the structure of ethanol in Part I. 
We want to delete all the atoms in indinavir except for the centeral ethanol fragment by 
proceeding as follows. Click on the hydrogen atom on the center –OH. Then shift click on the 
adjacent oxygen, carbon, and the adjacent carbon. Also shift click on the hydrogens attached to 
the two selected carbons. The atom selections should look something like this: 
 

 
Figure 12. Central ethanol fragment from indinavir highlighted before atom deletion. The 
squares on the atoms are colored pink. Seven atoms are selected. 
 
9. Pull down the Selection menu and choose Invert . Click on the Delete… button on the right-
hand side of the screen. Now only ethanol should appear on the screen. The program 
automatically fills in unfilled valences with hydrogens. While carefully watching the screen and 
the –OH group, click on the Minimize  button to find the lowest energy conformation for this 
ethanol. Note that the atoms don't need to move much to find their lowest energy positions. In 
other words, the basic structure of this free fragment is not much distorted from the conformation 
in the binding pocket. 
 
10. Pull down the File menu and choose Quit . 
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LABORATORY REPORT:  
No Introduction, Theory, or Procedure sections are needed. Simply give the two requested 
plots and answer the questions, below. 
 
1. Give your sketch for the dihedral energy plot for methanol. 
 
2. Give your sketch for the dihedral energy plot for Indinavir interacting with aspartate. 
 
3. Is the minimum energy dihedral angle for Indinavir interacting with aspartate similar to one of 
the minimum energy conformations for methanol? How does the energy difference, maximum – 
minimum, for Indinavir compare with methanol? Why does this happen (think about the bond 
polarity of the –OH and the charge on COO-)? 


